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Adobe Reader for Pocket PC 2.0
Adobe® Reader® for Pocket PC 2.0 extends the value of Adobe Portable Document Format 
(PDF) files beyond desktop computers to handheld devices running Pocket PC software. 

Part of Adobe’s Network Publishing vision, Adobe Reader for Pocket PC lets you read PDF 
files downloaded from a desktop computer or accessed directly using a wireless link, 
letting you access them anytime and anywhere. Adobe Reader for Pocket PC software 
preserves the rich content of PDF files—styled text, images, and bookmarks—and adapts 
them for viewing on small screens. It supports PDF files created with Adobe Acrobat 6.0 or 
earlier. It also lets you view Digital Editions (also called eBooks), make presentations using 
external VGA cards, play PDF slideshows, print on Hewlett-Packard (HP) printers, fill out 
Adobe Form Designer forms, and view documents in landscape mode. 

About Adobe Reader for Pocket PC 2.0 Help 
This guide explains how to use Adobe Reader for Pocket PC software and how to transfer 
and view PDF documents on your Pocket PC. 

You should have a working knowledge of the Pocket PC functionality and conventions. For 
help using your Pocket PC, please refer to its documentation.

About tagged PDF files
Tagged PDF files provide the best reading experience for Pocket PCs because text and 
images can be easily reflowed to fit the screen size. To properly reflow a PDF document on 
your Pocket PC’s screen, Adobe Reader for Pocket PC must interpret the document’s 
structure.

The ActiveSync component installed with Adobe Reader for Pocket PC attempts to tag any 
untagged PDF files as they transfer to your Pocket PC. The new tagged PDF files may be 
somewhat larger. The results may vary depending on the quality and complexity of the 
source files, and ActiveSync may not be able to create tags for some documents. Untagged 
PDF documents appear as intended for a computer monitor, not optimized for your Pocket 
PC. You can create tagged PDF files with Adobe® Acrobat® 6.0, Adobe® PageMaker® 7.0, or 
Adobe® InDesign® 2.0 or later, as well as with Microsoft Office 2000 and Office XP applica-
tions using the PDFMaker utility that installs with Acrobat 6.0.

Transferring PDF files
You transfer PDF files to your Pocket PC by dragging them to the Mobile Device folder on 
your desktop. You can also disable tagging PDF files in the ActiveSync application.

To transfer a PDF file to your Pocket PC:

Drag the PDF file to the Mobile Device folder in My Computer. The next time you connect 
your Pocket PC, ActiveSync automatically transfers the file.
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To transfer a PDF file to a storage card:

1  In the Mobile Device Folder in My Computer, go to the folder for the storage card and 
create a new folder called My Documents.

2  Drag the PDF file to the My Documents folder. The next time you connect your Pocket 
PC, ActiveSync automatically transfers the file to the storage card.

To disable tagging during document transfer:

1  Start ActiveSync.

2  Choose Tools > Options.

3  Tap the Rules tab, and then tap Conversion Settings.

4  Tap the Desktop To Device tab, choose the file type Adobe Acrobat Document, and then 
tap Edit.

5  Under Convert To Mobile Device Files Of The Type, choose (No conversion)(*.pdf).

6  Tap OK to return to the desktop.

Note: To restore tagging during document transfer, repeat the procedure, selecting Adobe 
Acrobat Tagged PDF Converter (*.pdf ) for the file type.

About the menus
Two menus are available in Adobe Reader for Pocket PC. The Main menu  provides 
general commands for opening new documents, setting preferences, and getting 
document information. The Viewing menu, which is a context menu that appears on-
screen, provides commands directly related to viewing and navigating an open document.

To display the Main menu:

Tap the Main Menu icon  in the toolbar.

To display the Viewing menu:

Tap and hold anywhere on the document. The menu pops up on-screen.

The Main menu (left) and the Viewing menu (right)
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About the toolbar
The toolbar appears along the bottom of the screen and can be customized using the 
Customize Toolbar dialog box (see “Customizing the toolbar” on page 4). You can display 
up to 11 tool icons, in addition to the Main Menu icon , which always appears. (Note 
that some icons take up more than one space, such as the Page Indicator icon, which takes 
up three spaces.)

In addition to the Main Menu icon, the default toolbar displays the following items: Open 
Document icon, Zoom In/Zoom Out icons, Default Zoom icon, Hand Tool icon, the Reflow 
icon, Previous/Next Page icons, and the Current Page Indicator/Go to Page selection box.

The default toolbar

There are six zoom controls, which are grouped together when displayed in the toolbar. 
The Zoom In icon  and the Zoom Out icon , the Dynamic Zoom tool , and the 
Default Zoom icon . The Dynamic Zoom tool is not in the toolbar by default, so you 
must add it if you want to use it.

The Zoom In tool and the Zoom Out tool are hidden under the zoom icons. For more infor-
mation about how to use these controls, see “Adjusting the view of PDF documents” on 
page 6.

Customizing the toolbar
Toolbar preferences determine which icons appear in the toolbar. You may choose up to 
11 icons to appear in the toolbar, and you may change which icons appear at any time by 
customizing the toolbar.

To customize the toolbar:

1  In the Main menu, choose Customize Toolbar.

2  Choose the icons you’d like to appear, and tap OK.

Note: A legend at the top of the Customize Toolbar dialog box indicates how many spaces 
are available for toolbar icons. To add more icons, you may need to deselect currently 
selected icons. 

Opening and closing documents
When you start Adobe Reader for Pocket PC, it opens a list of the PDF files available on 
your Pocket PC, both in main storage or on a storage card. You can view only one PDF file 
at a time. Opening a new document closes the current document. 

To open a document:

1  Display a list of available PDF files by using one of these methods:

• Start Adobe Reader for Pocket PC.

• In the Main menu, choose Open.

• Tap the Open Document icon  in the toolbar.

2  Tap the file name of the document in the file list that appears.
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Changing the viewing mode
There are two viewing modes for Adobe Reader for Pocket PC: Reflow mode and Layout 
mode. 

Reflow mode reflows text to fit the display area of your Pocket PC. Reflow mode is the 
default viewing mode; when Reflow is not selected, documents appear in Layout mode. 
Because untagged PDF files cannot be reflowed, the viewing mode defaults to Layout 
when you open an untagged PDF file. 

Layout mode displays the document in its original format with the toolbar and scroll bar 
visible.

To maximize the display area, you can display the document in Full Screen mode. When 
this option is selected, the navigation tools at the bottom of the screen and the scroll bar 
at the right of the screen are hidden. Text automatically reflows to fill the display area. You 
can use Full Screen mode in either Reflow or Layout modes. To temporarily restore the 
toolbar and scroll bar, tap in the area where the scroll bar would be. If no action is taken 
promptly, the tools disappear.

To change the viewing mode:

In the Viewing menu, tap one of the following buttons:

• Reflow. This button (default is on) switches between Reflow and Layout modes. (You 
can also switch between Reflow and Layout modes by tapping the Reflow icon  in 
the toolbar. If you selected the Default Zoom Turns Reflow On option in the General 
Preferences panel, tapping the Default Zoom icon turns Reflow on.)

• Full Screen. This button toggles Full Screen mode on or off.

To temporarily restore navigation tools in Full Screen mode:

Tap in the right-hand margin (where the scroll bar normally is). The scroll bar and 
navigation tools temporarily appear on top of the document, without the page reflowing 
to fit the reduced display area. 

After you use any of the navigation tools, they disappear. 

Scrolling through documents
You can scroll through the document in many ways, such as using the scroll bar, dragging 
in the document pane, tapping the screen, and using the Next Page and Previous Page 
buttons.

To use the scroll bar:

Do one of the following procedures: 

• Tap and hold an arrow to scroll continuously in either direction. 

• Drag the handle in the middle of the scroll bar to move quickly up or down through the 
document. 

• Tap in the area above or below the handle to move up or down one screenful at a time.

To drag:

Do one of the following procedures:
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• In Layout mode, tap anywhere in the screen and drag to move the document up or 
down. 

• In Reflow mode, drag vertically or at an angle of more than 45 degrees from the 
horizontal to move to the page in the direction you’re dragging. (Dragging horizontally 
in Reflow mode selects text.)

To screen tap:

1  Choose Options from the Main menu, and choose Tap Screen For Prev. Or Next.

2  (Optional) Choose whether to scroll horizontally or vertically:

• If you choose to scroll vertically, tapping in the top half of the screen scrolls the 
document backwards, and tapping in the bottom half scrolls the document forward. 

• If you choose to scroll horizontally, tapping in the left half of the screen scrolls to the 
left, and tapping in the right half scrolls to the right. 

3  (Optional) Choose whether to scroll by the screenful or by the page. 

To go to the next or previous page:

Tap the Next Page button  or the Previous Page button  in the toolbar. Tap and hold the 
button to scroll the document continuously page by page.

To scroll automatically:

1  Tap and hold in the document pane, and choose Automatically Scroll from the Viewing 
menu. The document scrolls forward.

2  (Optional) To change the speed and direction of the scrolling, use the Pocket PC’s Up 
and Down cursor buttons.

3  (Optional) To stop scrolling, tap and hold in the document pane, and deselect Automat-
ically Scroll from the Viewing menu.

To move forward or backward:

In the Viewing menu, choose Go Back or Go Forward.

To go to a specific page:

1  Tap the current-page indicator .

2  Enter a page number by tapping the on-screen keyboard.

3  Tap Enter on the keyboard.

Tip:You can also move to a specific page in the document by tapping and holding the 
handle in the side scroll bar. The current page and total number of pages appear in the 
document pane. The current-page display updates as you drag the scroll bar, allowing you 
to scroll to a specific page in the document.

Adjusting the view of PDF documents
You can change the magnification level of a PDF document using the zoom icons and 
commands. In Reflow mode, zooming affects only text size, not images. To change the 
magnification of images, you must be in Layout mode.
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The default zoom magnification is set to 112%. You can change this value using the 
General tab of the Options dialog box. For more information, see “Viewing in landscape 
mode” on page 8. You can easily return to the default zoom magnification by choosing the 
Default Zoom command, or by using the Default Zoom icon  in the toolbar.

To change text size and page magnification:

Do one of the following procedures:

• If you have set the preferences to display zoom icons in the toolbar, tap the Zoom In 
icon  or the Zoom Out icon  to increase or decrease magnification.

• In the Viewing menu, choose Zoom In or Zoom Out.

To dynamically change the magnification for a portion of the document:

1  In Layout mode, tap the Dynamic Zoom tool .

Note: The Dynamic Zoom tool is not in the toolbar by default. You can add it by choosing 
Customize Toolbar from the Main menu.

2  Tap in the area you want to zoom, and drag up to increase magnification or drag down 
to decrease magnification.The more you drag, the more the magnification changes. 

To display hidden zoom tools:

1  Tap and hold the zoom icon corresponding to the zoom tool you want to use.

2  When the hidden zoom tool appears in a pop-up menu, release the stylus. The pop-up 
menu remains visible. 

3  Tap the icon, and the corresponding zoom tool replaces the zoom icon in the toolbar.

Tip:To restore the zoom icon to the toolbar, you may repeat the process, or simply tap the 
zoom tool in the toolbar without holding it. The zoom tool is deselected and replaced with 
the corresponding zoom icon.

To change the magnification for a selected portion of the document:

1  In Layout mode, choose the Zoom In icon .

2  Drag a marquee around the area you want to magnify.

The selected area of the document, and the same area after zooming in
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To return to the Default Zoom view:

Do one of the following procedures:

• In the Viewing menu, choose Default Zoom.

• In the toolbar, tap the Default Zoom icon .

Changing the orientation of a document
You can change the orientation of the document from portrait to landscape view by using 
the Rotate Clockwise icon  or the Rotate Counterclockwise icon . To display these 
icons, choose the Rotate View tool in the Customize Toolbar dialog box. When displayed in 
the toolbar, the Rotate Clockwise icon appears by default, and the Rotate Counter-
clockwise icon is hidden. For information on accessing hidden toolbar icons, see 
“Adjusting the view of PDF documents” on page 6.

Viewing in landscape mode
Adobe Reader for Pocket PC fully supports landscape mode. 

Setting general preferences
General preferences determine tap behavior and other navigational behaviors.

To set General preferences:

1  In the Main menu, choose Options.

2  Choose from the following General options, and tap OK:

Tap Screen For Prev. Or Next  Lets you navigate a document by tapping the screen. 
Selecting the horizontal or the vertical split screen moves the page when you tap it in the 
corresponding area of the screen. Also, choose to move forward or backward a screenful at 
a time, or a page at a time, by selecting the appropriate option. 

Default Zoom  Sets the default magnification anywhere from 25% to 1600%. The default 
is 112%.

Never Load Print Plugin Prevents you from printing documents. Choose this option if 
you need to save memory on your Pocket PC.

Never Load Forms Plugin Prevents you from filling out forms. Choose this option if you 
need to save memory on your Pocket PC.

Show Images  Displays graphics. If this option is off, every graphic is replaced by a box of 
the same size with an X in it. 

Hardware Buttons Scroll A Screen Full  Allows you to use scroll buttons on your device 
to scroll the document view by one screen full at a time. 

Retain View On Close  Remembers the last view when you close the document. The next 
time you open the document, you’ll see the same view just as you left it. This option is 
selected by default.

Always Try To Reflow On Open  Opens a document in Reflow mode if the document is 
reflowable. If the document isn’t, it opens in Layout mode and the Reflow toggle 
command is disabled. The default is on.

Switch Back To Hand Tool After Zoom  Automatically selects the Hand tool after one 
action of a zoom icon. The default is off.
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Default Zoom Turns Reflow On Enables returning to Reflow mode automatically when 
the default zoom command or tool is used. The default is off. 

Cache Next Page In Reflow When you’re viewing a page in a Reflow mode, this option 
caches the next page so it takes little or no time to flip pages. Turn this option off if you 
need to reduce your memory usage. The default is on. 

Setting appearance preferences 
Appearance preferences allow you to change the color of your display. You can customize 
text color as well. 

To set Appearance preferences: 

1	 In the Main menu, choose Options. 

2	 Tap Appearance. 

3	 Choose from the following options: 

•	 	 Override Document Colors changes the default color scheme. To change a color, choose 
the option, and then tap the color swatch for Background Color or Text Color. Choose a 
new color by tapping the color name. 

•	 	 Change Only The Color Of Black Text keeps text color as-is, except for black text. 

•	 	 Select Change The Color Of Line Art customizes line art display. 

Using the navigation pane 
In addition to the main document pane, Adobe Reader for Pocket PC provides a navigation 
pane. Navigational structures in the navigation pane allow you to move quickly to specific 
places in PDF documents: 

•	 	 Bookmarks display the list of bookmarks that the document contains. Generally, this is a 
visual table of contents that represents the chapters, main headings, and other organi-
zational elements in a document. If you select the Show Page Numbers option from the 
Bookmarks palette menu, the page numbers for the bookmarks are shown as well. 

•	 	 Pages provide miniature previews of document pages. You can use pages to change the 
display of pages and to go to other pages. A page-view box in a preview indicates the 
area of the page currently showing in the document pane. 

•	 	 Articles are electronic threads that lead you through a document. An article typically 
begins on one page and continues on another, as in traditional newspapers and 
magazines. 

Each of these navigation elements appears by tapping its tab in the navigation pane. 

The navigation pane with the Bookmarks tab selected 

The navigation pane with the Pages tab selected 

9 
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To display the navigation pane:

Do one of the following procedures:

• Tap the Show/Hide Pane icon  in the toolbar.

• Tap the divider bar .

• In the Main menu, choose Show Bookmarks.

Note: The Show/Hide Pane icon isn’t in the toolbar by default. You can add it by choosing 
Customize Toolbar from the Main menu.

To close the navigation pane:

Do one of the following procedures:

• Tap the Show/Hide Pane icon  in the toolbar.

• Tap the divider bar.

• If the Bookmarks tab is active, choose Hide Bookmarks in the Main menu. (If another tab 
is active, choosing Show Bookmarks changes the active tab to the Bookmarks tab.)

To navigate using bookmarks:

1  Tap the Bookmarks tab. If the tab is hidden, choose Show Bookmarks from the Main 
menu.

2  To jump to a topic, tap the bookmark’s icon or text in the palette. The icons for the 
bookmarks currently displayed are dimmed.

3  To view subtopics under a topic, tap the plus sign beside the topic. Tap the subtopic’s 
bookmark icon to view it. To hide the subtopics under a topic, tap the minus sign beside 
the topic.

Tip:To choose the bookmark for the topic showing in the document pane, choose Find 
Current Bookmark from the Bookmarks palette menu, or tap the Find Current Bookmark 
button  at the bottom of the Bookmarks palette. If the bookmark is hidden in a 
collapsed parent bookmark, the parent bookmark opens.

To hide the navigation pane after using a bookmark:

Open the Pane menu  and choose Hide After Use. 

To show the navigation pane again, tap the Show/Hide Navigation Pane button on the 
toolbar. Deselect Hide After Use in the navigation pane’s palette menu if you want the 
navigation pane to remain open after you tap a bookmark. 

To browse using a thumbnail:

Tap the Pages tab, and do one of the following procedures:

• To jump to another page, double-tap the page’s thumbnail.

• To display another part of the current page, drag the edge of the page-view box in the 
page’s thumbnail to move the view area.

To move to a specific point in an article:

1  Do one of the following procedures:

• In the Articles palette, tap the article’s icon to start reading it at that point.

• Choose the Hand tool , and tap in the article to start reading it at that point.
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2  To go to the next page in the article, tap anywhere in the article.

Retracing your viewing path
After you’ve paged through documents or used navigational structures to move through 
documents, you can retrace your path back to where you started. 

To retrace your viewing path:

Do any of the following procedures:

• Tap the Back button  or the Forward button  in the toolbar.

Note: The Back and Forward buttons aren’t in the toolbar by default. You can add them by 
choosing Customize Toolbar from the Main menu.

• In the Viewing menu, choose Go Back or Go Forward.

Viewing comments 
Comments are annotations created in Acrobat and attached to pages in a PDF document. 
Although you cannot create new comments using Adobe Reader for Pocket PC, you can 
view comments. 

Comments appear as sticky notes on the document. When you open the document, 
comments that were open when you last viewed it are opened again. Comments are 
moved if needed to fit on-screen.

To open a comment:

Double-tap the sticky note.

To close a comment:

Choose the comment, and tap the close bar that appears in the upper left corner. 

The close bar is located in the upper left corner of the open comment.

To move a comment:

Drag the comment to a different location on the page. As you drag a comment near the 
edge of the screen, the page scrolls in that direction.

Note: You can move comments to view the document, but they return to their original 
position when you change the view of the document. 
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Searching a document
You can search for occurrences of a word, phrase, or number in a document by using the 
Find command. 

The Find dialog box and on-screen keyboard (left), and the results of the search

To search a document:

1  In the Main menu, choose Find, or tap the Find icon  in the toolbar.

2  Type in a search word or phrase using the on-screen keyboard.

3  Choose search options:

• From Current Page searches from the current page to the end of the document, and 
then from the beginning to the current page.

• From Beginning searches the entire document from beginning to end.

• From Page __ To __ enables you to specify a page range for the search.

• Exact Match returns results that match the entire word. 

• Case Sensitive returns results that match the case of the search string.

4  Tap Find. The search result is highlighted on the page. A results dialog box appears as it 
searches. To cancel a search in progress, tap Stop.

5  When you’ve found the results, you can choose one of the following options:

• Tap the X in the corner of the Search Results dialog box to end the search and remain at 
the page with the results.

• Tap Find Prev. to search for a previous occurrence.

• Tap Find Next to search for the next occurrence.

• Tap New Find to begin a new search.

Copying text
You can select text in a PDF document, copy it, and paste it into a document in another 
application on your Pocket PC. Copying and pasting text enables you to move data to 
programs such as a word-processing application.

To copy text: 

1  Select text using one of the following methods:
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• In Reflow mode, drag horizontally over text, and then, without lifting the stylus, drag 
vertically to select more than one line.

• In Layout mode, select the Text/Column Selection tool , and drag through the text 
you want to select. 

• Tap and hold in the document pane, and choose Select Current Page from the Viewing 
menu. All the text (and none of the images) in the current page is selected. 

2  Tap and hold in the document pane, and choose Copy from the Viewing menu. The 
selected text is copied to the clipboard.

3  Cancel the selection by tapping anywhere in the document.

Viewing document information
The Document Properties dialog box provides information about the document, including 
the document’s name, title, subject, and author. This dialog box also displays attributes set 
by Acrobat, PDFWriter, or Acrobat Distiller®. If you’re reading a Digital Edition, the Digital 
Edition tab of the Document Properties dialog box provides information including the 
author, publisher, identifier, and expiration time, if applicable. (For more information about 
Digital Editions, see “Reading Digital Edition files” on page 15.)

The Document Properties dialog box

To view document information:

In the Main menu, choose Document Properties. The Document Properties dialog box 
appears. The title, subject, author, and keywords may have been set by the author to help 
you identify the document. The following information is also available:

Security Method How the document is protected.

Application The application that produced the original document.

PDF Producer The application or driver that converted the original document into a PDF 
document.

Created  The date and time the document was created.

Modified The date and time the document was last modified.

PDF Version Indicates the PDF version number.

Tagged PDF  Indicates whether structural information about the PDF document has 
been tagged.



14  

Adobe Reader for Pocket PC Help Adobe Reader for Pocket PC 2.0 

14  

File Size (KB) The size of the PDF file in kilobytes.

Printing Whether you can print the document.

Printing PDF documents
You can print PDF documents from your Pocket PC to any printer connected to your device 
via Bluetooth, IR (infrared), or a network.

To print a document, the following must be true:

• The document’s author set the Printing Allowed option. You can check whether the 
author set that option by choosing Document Properties from the Main menu.

• The Never Load Print Plugin option in the General tab of the Options dialog box is 
deselected.

• You have installed the HP Mobile Printing SDK for Pocket PC on your Pocket PC. You can 
find the SDK at http://www.hpdevelopersolutions.com/mobile/index.cfm.

The Print Preferences dialog box

To print a document:

1  In Layout mode, choose Print from the Main menu.

2  Set printing options, and tap OK.

3  If a printer isn’t configured, tap Configure to add it.

4  Tap Print. A dialog box shows the progress.

Reading Digital Edition files
Adobe Reader for Pocket PC works with your desktop computer’s copy of Adobe Reader or 
Acrobat to let you view Adobe Digital Edition files, also called eBooks, on your Pocket PC. 
To read Digital Editions on your Pocket PC, you must have a copy of Adobe Reader or 
Acrobat on your desktop computer that’s been activated as a Digital Edition reader. You’ll 
use that copy of Adobe Reader or Acrobat to activate your Pocket PC as a Digital Edition 
reader, and to send Digital Editions to your Pocket PC. 

Note: Digital Editions are specially encrypted PDF files that you cannot copy to your Pocket 
PC in the same way as other PDF files. To read Digital Editions on your Pocket PC, you must 
first complete the procedures in this section.

To activate a Pocket PC as a Digital Edition reader after you’ve activated a desktop 
computer:

1  Connect your Pocket PC to your desktop computer

2  Make sure that your desktop computer is connected to the Internet.

http://www.hpdevelopersolutions.com/mobile/index.cfm
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3  On your desktop computer, open Acrobat or Adobe Reader, and do one of the following 
procedures:

• In Acrobat, choose Advanced > Digital Editions > Authorize Devices.

• In Adobe Reader, choose File > Digital Editions > Authorize Devices.

4  On the Adobe DRM Activator website, log in with the same Adobe or .NET ID that you 
used when activating Adobe Reader or Acrobat on your desktop computer.

5  When the Activation web page appears, click Activate Pocket PC Device. After a short 
time, a message appears stating that your Pocket PC has been activated. 

6  Sign out. You’re now ready to send Digital Editions to your Pocket PC.

To send a Digital Edition to a Pocket PC:

1  On your desktop computer, open Acrobat or Adobe Reader, and do one of the following 
procedures.

• In Acrobat, choose Advanced > Digital Editions > My Digital Editions.

• In Adobe Reader, choose File > Digital Editions > My Digital Editions.

2  Choose a Digital Edition and click Send To Mobile Device, or right-click a Digital Edition 
and choose Send to Mobile Device.

3  In the dialog box that appears, click Prepare to prepare the Digital Edition and send it to 
the Pocket PC. After a short time, a dialog appears to tell you that the Digital Edition has 
been successfully copied.

4  On your Pocket PC, open Adobe Reader, choose Open from the Main menu, and choose 
the Digital Edition.

Working with PDF slideshows
Adobe Reader for Pocket PC can display any PDF slideshow that you receive, for example, 
over the web or e-mail. You can create PDF slideshows with several Adobe applications, 
including Adobe Photoshop® Album and Adobe Photoshop® Elements. When you view a 
PDF slideshow on your Pocket PC, you can listen to audio tracks it contains if your Pocket 
PC supports them, and you can control how the slideshow appears by setting PDF 
Slideshow preferences.

To view a PDF slideshow:

1  Choose Open from the Main menu, and choose the PDF slideshow file.

2  If the PDF slideshow doesn’t start, choose Start PDF Slideshow from the Main menu. 

3  To stop a slideshow, tap and hold in the document pane, and choose End PDF 
Slideshow from the Viewing menu.

4  To jump to the first page, last page, previous page, or next page in the PDF slideshow, 
tap and hold in the document pane, and choose the page you’d like to see from Viewing 
menu.

5  To pause the PDF slideshow if it’s playing automatically, tap and hold in the document 
pane, and choose Pause from the Viewing menu.

To set PDF Slideshow preferences:

1  Choose Options from the Main menu. 
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2  Tap PDF Slideshow, and choose from the following options:

• Background Color lets you choose the window’s background color. Tap the swatch and 
choose a new color.

• Change Page Every __ Seconds lets you choose whether to automatically advance the 
slideshow at the specified interval.

• Loop After Last Page returns to the first slide after displaying the last slide. Otherwise, if 
you also don’t choose to automatically advance the slideshow at a specified interval, 
the slideshow stops after the last slide.

• Transition lets you choose the transition effect used when changing pages.

• Rotate Page Clockwise By __ rotates a page in your presentation by the specified 
amount. Use this option if you want to hold your Pocket PC sideways while presenting.

• Play Background Music plays any background music specified in the slideshow.

• Open in Slideshow Mode automatically opens all slideshows in slideshow mode. 
Otherwise, you must choose Start PDF Slideshow from the Main menu to start a 
slideshow after opening it.

Working with presentations
Using Adobe Reader for Pocket PC, you can connect your Pocket PC to a projector to share 
presentations on an external display. You need an external VGA card to connect to other 
devices.

Note: Adobe Reader for Pocket PC supports only those VGA cards supplied by Colorgraphic 
Communications or Margi Systems.

Adobe Reader for Pocket PC provides the following modes for working with presentations:

Auto mode This mode enables the presentation slides to advance after every set flip time 
period, both on the Pocket PC and the external display. Tap the presentation to stop auto 
mode. By default, auto mode is off.

Pause mode This mode enables you to work on the Pocket PC without displaying your 
changes on the external display. The Pen tool, Pointer tool, Whiteboard mode, and Auto 
mode are disabled. Clicking Resume Presentation in the Main menu enables you to resume 
displaying changes on the external display.

Whiteboard mode This mode enables you to write on a whiteboard on the Pocket PC, 
and display the whiteboard on the external device. Use the Pen tool to write on the white-
board. You can also erase the whiteboard and switch back to the active Presentation 
mode. While in Whiteboard mode, hold the Pocket PC 90 degrees counterclockwise with 
respect to the orientation of the Pocket PC in the active Presentation mode.

You can use the following tools while working with presentations:

Note: To switch between these tools, tap the page in presentation mode. A context menu 
appears that lets you choose another tool.

Pen tool  This tool enables you to write on the Pocket PC presentation and display the 
writing on the external display.

Pointer tool This tool enables you to move the stylus on the Pocket PC. A pointer icon 
appears on the external display, and is always in sync with the position of the stylus on the 
Pocket PC.
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Presentation preferences give you control over how your presentations appear when you 
attach your Pocket PC to a projector. You can reset Presentation preferences to suit 
individual presentations.

To set Presentation preferences:

1  In the Main menu, choose Options. 

2  Tap Presentation, and choose from the following options:

• Background Color shows you available colors for the screen’s background during a 
presentation. Tap the swatch, and choose a new color by tapping a color name.

• Pen Color lets you choose the color of the pen you can use to draw on the presentation.

• Transition lets you choose the transition effect used when changing pages.

• Pen Width determines the width of the pen you can use to draw on the presentation.

• Eraser Width determines the width of the eraser you can use to erase on the whiteboard 
during the presentation.

• Advance Every __ Seconds lets you choose whether to automatically advance the 
presentation at the specified interval.

• Loop After Last Page returns to the first slide after displaying the last slide.

• Rotate Device Page By __ enables you to hold your Pocket PC at a 90 degree angle and 
view the presentation in that orientation.

Working with forms
A PDF form is an electronic-based form, resembling a traditional paper form, that can 
collect data from a user. Adobe Reader for Pocket PC can submit data for any form that 
uses the XFA format, such as those created by Adobe Designer.

If you’re connected to the web, you can fill out the form and submit it immediately. 
Otherwise, you can fill out the form and submit it when you’re connected. You can also 
choose to send the data via e-mail or export it to a file.

To fill out a form, the following must be true:

• The document’s author enabled filling of form fields in Acrobat.

• The Never Load Forms Plugin option in the General tab of the Options dialog box is 
deselected.

Note: Adobe Reader for Pocket PC supports the scripting language FormCalc. It doesn’t 
support JavaScript, cannot update or validate calculations automatically, or populate a 
form’s fields automatically from a database.
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A PDF form

To submit form data:

Fill out the form and tap the button on the form that submits its data. One of the following 
occurs:

• If you’re connected to the Internet, Adobe Reader for Pocket PC sends the data immedi-
ately. 

• If you’re not connected to the Internet, Adobe Reader for Pocket PC asks if you want to 
save the data and send it later.

To submit saved data: 

Connect your Pocket PC to the Internet. If you have saved data on your Pocket PC, it 
prompts you to submit the data and starts Adobe Reader if necessary. If your Pocket PC 
doesn’t prompt you to submit the data, do the following procedure:

1  Connect your Pocket PC to the Internet and display the Submit Offline Data dialog box 
by doing one of the following procedures:

• If the form is open, choose Forms >Submit Offline Data from the Main menu.

• If the form isn’t open, choose Open from the Main menu, choose the form, and agree to 
submit the form’s cached data.

2  Tap the arrow at the top right and choose one of the following options from the pop-up 
menu:

• Submit All sends all the saved data immediately.

• First Record, Next Record and Previous Record display that record’s data in the form. 
Each record represents a time when you saved a form’s data. To send that data, tap the 
button on the form that submits its data. 
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To submit form data by using e-mail: 

Do one of the following procedures:

Note: Your Pocket PC must already be set up to send e-mail and be connected to the 
Internet.

• If the form has a button that e-mails the data, tap the button. Adobe Reader for Pocket 
PC mails the data.

• Choose Forms > Mail Forms Data from the Main menu, and enter the e-mail address to 
which to send the data. Adobe Reader for Pocket PC mails the data to the specified 
address as an attachment.

To export form data to an XML file:

1  Fill out the form.

2  Do one of the following procedures:

• If the form has a button that exports the data, tap the button.

• Choose Forms > Export Forms Data from the Main menu. 

3  In the dialog box that appears, choose how to export the data and specify the name 
and location for the file.

4  Tap OK.

To import saved data into a form:

1  Choose Forms > Import Forms Data from the Main menu. 

2  Choose a file, and tap Select.

Note: If you import data that doesn’t match the form, only the matching fields are 
updated, and the rest are ignored. Existing text in fields is replaced only if data is imported 
into them.
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Legal Notices
Copyright © 2004 Adobe Systems Incorporated. All rights reserved.

Adobe® Acrobat® Reader® for Pocket PC® 2.0 User Guide for Windows®

This guide, as well as the software described in it, is furnished under license and may be used or copied only in accordance with the terms of 
such license. Except as permitted by such license, no part of this publication may be reproduced, stored in a retrieval system, or transmitted, in 
any form or by any means, electronic, mechanical, recording, or otherwise, without the prior written permission of Adobe Systems Incorpo-
rated. Please note that the content in this guide is protected under Copyright law even if it is not distributed with software that includes an 
end user license agreement.

The content of this manual is furnished for informational use only, is subject to change without notice, and should not be construed as a 
commitment by Adobe Systems Incorporated. Adobe Systems Incorporated assumes no responsibility or liability for any errors or inaccuracies 
that may appear in this guide. 

Please remember that existing artwork or images that you may want to include in your project may be protected under copyright law. The 
unauthorized incorporation of such material into your new work could be a violation of the rights of the copyright owner. Please be sure to 
obtain any permission required from the copyright owner.

Any references to company names in sample templates are for demonstration purposes only and are not intended to refer to any actual 
organization.

Adobe, the Adobe logo, Acrobat, and Adobe Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the 
United States and/or other countries. Microsoft, Windows and Windows NT are either registered trademarks or trademarks of Microsoft Corpo-
ration in the United States and/or other countries. Pocket PC is either a registered trademark or trademark of Palm, Incorporated. All other 
trademarks are the property of their respective owners.

Portions of Adobe Acrobat include technology used under license of Verity, Inc. and are copyrighted.

Contains an implementation of the LZW algorithm licensed under U.S. Patent 4,558,302.

Adobe Systems Incorporated, 345 Park Avenue, San Jose, California 95110, USA.

Notice to U.S. Government End Users. The Software and Documentation are “Commercial Items,” as that term is defined at 48 C.F.R. §2.101, 
consisting of “Commercial Computer Software” and “Commercial Computer Software Documentation,” as such terms are used in 48 C.F.R. 
§12.212 or 48 C.F.R. §227.7202, as applicable. Consistent with 48 C.F.R. §12.212 or 48 C.F.R. §§227.7202-1 through 227.7202-4, as applicable, the 
Commercial Computer Software and Commercial Computer Software Documentation are being licensed to U.S. government end users (a) 
only as Commercial Items and (b) with only those rights as are granted to all other end users pursuant to the terms and conditions set forth 
herein. Unpublished rights reserved under the copyright laws of the United States. Adobe Systems Incorporated, 345 Park Avenue, San Jose 
California 95110-2704, USA. For U.S. Government End Users, Adobe agrees to comply with all applicable equal opportunity laws including, if 
appropriate, the provisions of Executive Order 11246, as amended, Section 402 of the Vietnam Era Veterans Readjustment Assistance Act of 
1974 (38 USC 4212), and Section 503 of the Rehabilitation Act of 1973, as amended, and the regulations at 41 CFR Parts 60-1 through 60-60, 60-
250, and 60-741. The affirmative action clause and regulations contained in the preceding sentence shall be incorporated by reference.
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